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Key Objectives

1. Graph experimental data.

2. Make a "good" looking graph.

3. Labeling and numbering of axis.
4. Adding a curve-fit to a graph.

Discussion

A picture is worth a thousand

It is often said that a picture is worth 1,000 words, or for scien- words

tists we might rephrase it to say that a graph is worth 1,000 words.
Graphs are most often used to express data in a clear, concise and
meaningful way. Trends are readily apparent, and information is
easy to extract. In today’s laboratory we will learn how to properly | If a picture is worth a thousand
present data in a graphical format. Graph terminology, basic graph | words, please paintme the
features, basic graphing skills using excel, and general graph func- | Gettysburg Address

tions will be mastered. -Leo Rosten

-unknown

Various types of graphs are possible, the most common type uses the Cartesian coordinate system
to show the relationship between two variables, the independent (x) and dependent (y) variables. The
independent (x) variable is generally controlled by the experimenter (or naturally increments) and is
plotted on the x-axis (horizontal axis) while the dependent (y) variable changes as the independent
variable changes and is generally plotted on the y-axis (vertical axis). The goal of any graph is to
maximize the amount of data shown in the space provided.

A. Graph Terminology

The terminology used in making graphs may be new to many of you. Figure 8.1 shows features com-
monly found on graphs.

1. X-axis: Generally the independent variable is plotted on the horizontal axis.
2. Y-axis: Generally the dependent variable(s) are plotted on the vertical axis.
3. Title: A general description of what is being graphed.

4. Axis Title: Titles for X and Y axis. The title should include a Label for what you are plotting and
the Units you are plotting with.
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Figure 8.1: Anatomy of a graph. credit: author

. Legend: Describes the independent variables being graphed. It includes the symbol representing

each individual variable and a description or identifier.

. Grid Lines: Lines on the graph drawn parallel to the X or Y axis. They generally are used as

guides for the eye to make it easier to see the value of data points.

Tick Mark: Small hash mark on X or Y axis that denotes a specific value. Major: A label and grid
line are normally drawn here. Minor: Normally just a tick mark on axis to indicate smaller units.
Normally not labeled or given grid lines.

. Tick Label: Label associated with tick marks on the X and Y axis.

. Data Symbols: Symbols used to mark the data points on a graph.

Error bars: Horizontal bars (X error bars) or vertical (Y error bars) sometimes found attached to
data points indicating the error involved in the measurement.

B. Good vs. Bad Graphs

A good graph is designed to convey a large amount of information in a small space. It is important to
make full use of the space provided to maximize the information. An example of a good graph is shown
in Figure 8.2. Several design goals are listed below.

1.
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Title - All graphs should have a title which conveys what is being graphed.
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Figure 8.2: An example of a good graph. credit: author

2. Labels - All graphs should have both axis properly labeled with what is being plotted and the units.

3. The x and y axis should use convenient units (both major and minor). The X and Y axis labels
are reasonably spaced (i.e. not too close together or too far apart).

4. Legend - All graphs should include a legend if more than one set of data is being plotted that
provides information about the different data sets.

5. Text should be readable. Don’t use fancy fonts or fonts too small to read.
6. Symbols used for data points should be:
(a) Proper size (not too big or small)

(b) Proper color (easy to distinguish). Generally use black and white only as people may not be
able to print graphs in color.

(c) Proper shape (don’t use crosses or dashes and avoid open symbols when possible)

(d) Avoid using duplicate shapes in different colors. It looks fine on a computer screen but if
printed in black and white it will be impossible to distinguish between them.

7. Maximize the size of your graph. It is often convenient to drag the Legend inside the graph so
that you can resize the graph and make it larger and easier to read.
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We will look next at several bad graphs. Figure 8.3 has several things wrong with it.
1. No title
2. Missing label on Y axis
3. Missing units on X axis

4. No legend

5. X axis units are too close together, overlap, and are nearly impossible to read.

6. Y axis units are spaced so far apart they are useless
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Figure 8.3: An example of a bad graph. credit: author
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Figure 8.4: Another example of a bad graph. credit: author

Another example of a bad graph is shown in Figure 8.4.

1.

2.

Title is not descriptive

X axis uses odd spacing and makes no sense. The minor tick marks are not evenly divisible units
of the major tick mark.

. The symbols used for the data points are poor: Series 1 is too big. Series 2 is too small. Series

3 is a hard to see color, (yellow is most often a poor color choice) and the symbol "-" is almost
impossible to see on the graph. Series 4 and 5 are the same symbol but different colors. It looks
good on the screen but if you print it in black and white you will not be able to tell the difference
between the symbols
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Figure 8.5: Another example of a bad graph. credit: author

One last example of a bad graph is shown in Figure 8.5.
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1.

The range of the X and Y axis is too large. The data does not span the range selected and ends
up in only one small corner of your graph. This leaves a lot of empty unused space which is a
waste.

. The labels for the X axis are too small to read. The font size should be increased.

. The labels for the Y axis are unnecessarily large and look out of place. The font size should be

decreased.

. The title is rather poor and non-descriptive.

. The curve fit information overlaps the axis and is hard to read.
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C. Graphing with a Computer

Increases in computing power in the last 20 years has lead to the practice of using computers to
graph data. This generally speeds up the process. While much of the process is now automated,
computers are not yet smarter than humans, and quite often make poor choices. The user needs to
make corrections to graphs where needed. In this class we will be using Microsoft Excel to plot our
data. It is not the best tool for the job (there are better professional software programs), however, it is
sufficient for our purposes and is installed on all campus computers. In the next section we will complete
a simple graph using Excel, followed by a general overview of the menu systems for modifying graphs,
and some information on how to use the Curve Fitting features of Excel to draw lines through your data
points.

D. Problem 1- Computer Graph 1

Using the following instructions we will now walk through how to make a graph using Excel using the
data given below.

Volume (mL) | Pressure (torr)
10.70 250.
7.64 350.
5.57 480.
4.56 600.
3.52 760.
2.97 900.
2.43 1100
2.01 1330

Table 8.1: Data for Practice Computer Graph 1.

Procedure

1. Open the Excel program. In Excel rename the first tab (Sheet 1) to Problem 1. To do this right
click on the Sheet 1 tab and choose the rename option. (Figure 8.6a).
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Figure 8.6: (a) Opening Excel (b) Entering data in Excel. credit: author

2. Add the data in Table 8.1 to the sheet. Go to Column A on the new Excel sheet that was opened
and in cell A1 type "Volume (mL)" and in B1 type "Pressure (torr)". Adjust the width of the columns
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if necessary. Now enter the data shown in the table. When finished entering the data highlight
the cells that contain your data, the results should look similar to Figure 8.6.

3. Create a graph by choosing the Insert tab and then Chart from the ribbon menu. A variety of
graph types are available to choose from, we will generally use the XY (Scatter) chart type with
the first sub-type shown (default choice).
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Figure 8.7: Chart Tool - Choose Scatter Plot. credit: author

4. After choosing the scatter plot option, you should be presented with a graph similar to that shown
in Figure 8.8. To make the graph easier to work with, you may wish to enlarge the graph by
clicking on the corners and dragging.
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Figure 8.8: Typical Scatter plot generated. credit: author '

5. Chart Tools: The current version of Excel uses a tabbed/ribbon menu system has placed many
useful tools for formatting your graph in 3 locations as shown below in Figure 8.9 which shows
the Layout tools and has the Axis Titles sub menu highlighted.
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Figure 8.9: Scatter plot with new x and y axis marks. credit: author
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(a) Chart Design Tab: This tab contains many options for formatting the data used in the plot,
and some layout features such as changing the shape and size of the data points on the
graph.

(b) Chart Layout Tab: This tab contains many options for formatting specific features of your
chart. You can add/change the Chart Title, Axis Titles, Legends, Data Labels, Grid Lines,
Trendlines and many other features.

(c) Chart Format Tab: This tab contains many options for formatting colors and fonts used in
your chart. You can change the color, font, shape, alignment and add special effects to your
graph.

6. There is no general rule for bringing up menu’s in Excel (which is one reason it can be frustrating).
In general double clicking on a feature will bring up the default menu, while right clicking (and
holding) will bring up a list with many options. To master the use of Excel requires practice and
patience.

7. There are several different menu’s for changing the major chart options, formatting the axis, for-
matting data series and many other options. You can access these options by left-clicking on the
desired feature and then right-clicking to bring up an options menu for that feature. For example,
left-clicking on labels for the y-axis will bring up the format axis menu which allows you to set
minimum and maximum values, spacings, tick marks and many other options. (See Figure 8.10.)

While you are here you may as well change the maximum value on the y-axis to 1600, the minor
unit to 50.0, and change the drop down menu for minor tick marks to show inside the graph.
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Figure 8.10: The Format Axis Menu. credit: author
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8. Now change the x-axis values (using what you have just learned) to label the axis every 2 units

10.

11.

12.

13.

14,

15.

16.

78

with a minor tick mark every 0.5 units. Change the labels on the axis to reflect the precision of
your data (to the hundredths). This can be accomplished by changing the number format in your
graph from "general" to "number" and choosing to display the numbers to 2 decimal places. The
resulting graph should now look similar to what is shown below in Figure 8.11.
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Figure 8.11: Scatter plot with new x and y axis marks. credit author

. The next several items are some of the more important options you can change. Explore! It is the

only way to really learn to properly use Excel to graph data.

Change the shape of your data points to be open circles with size = 8.

Add Axis titles to your graph. Label the x-axis Volume (mL) and the y-axis Pressure (torr).
Add a Chart title to your graph. Name the Graph: Computer Graph 1 - Volume vs. Pressure.
Remove the minor and major grid lines.

Add a border line around the entire graph.

Move the Legend inside the graph (it is a waste of space to leave it outside the graph).

Resize your graph to make maximum use of the space on the page.
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17. Curve Fitting/Trend Lines: It is often desirable to either draw a line though your data to make it

18.

19.

20.

easier to follow separate data sets, or more importantly to fit a mathematical equation to your
data in order to extract experimental information. The most common equation to fit to is that of
a straight line with the formula y = mx + b where m = slope and b = intercept. It is also useful
to print the R? value of the equation, because it tells you how good of a curve fit it is, 1 = perfect
correlation, 0 = no correlation. An R? value greater then 0.95 is generally considered good,
anything lower indicates either poor data or the equation used to fit the line is not the correct one.

(a) Open the Add Trend line menu (Figure 8.12) by selecting a data point on the graph and
right clicking or chosing the Trendline option on the Chart Tools Layout menu.

(b) Under the Type tab select Power Series.

(c) Under the Options tab select the boxes to display the equation on the chart, and to display
the R-squared value.

(d) Move the equation and R-squared value to nice location that does not overlap anything.

Format Trendline 2ixl
o i Trendline Options
Line Color r Trend/Regression Type

Line Style Exponential

Shadow
Linear
Glow and Soft Edges

Logarithmic

Polynomial |L E‘

* Power

71 € Moving Average |:- 5‘

r Trendline MName

& Automatic : Power {Pressure {torr))
 Custom:

Forward: 0.0 periods

Backward: ID.D periods
= |.:-.._:

[V Display Equation on chart
¥ Display R-squared value on chart

 Forecast ‘

Close

Figure 8.12: Adding a curve fit (trend line). credit: author

Add your name and date to the upper right hand corner of your graph. You can use the Insert
tab or the Chart Tools Layout tab which are selectable from the top menu. Select the Add Text
box option.

Take one last look at your graph. It should look similar to the one shown in Figure 8.13. Are there
any more changes you need to make? If so make them.

You should be done with your graph now. Show it to your instructor, and print a copy to be turned
in with this lab.
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Figure 8.13: Completed computer graph. credit: author

E. Problem 2: Computer Graph 2

Using data provided in Table 8.2 you will make a graph following the instructions below. The data shows
the temperature effect on the solubility (how many grams will dissolve in 100. g of water) of four salts.
The temperature (x-axis) is measured in °C and the solubility (y-axis)in grams substance/100 g water.

1. Type the data set into Excel.

2. The degree symbol for °C is found on the top tab under Insert than the Symbols menu. Scroll to
the top and click down three rows, it is located on the right side.

3. Using the mouse highlight the entire data set.
4. Choose the XY (scatter) plot and Click Next.
5. Click the Grid lines tab and add vertical grid lines. Click Next.
Now its time to make the graph look better. Make the following changes to your graph:

1. Change scales on axis. You may need to turn off the "auto” feature in Excel in order to set specific
values.

(a) Change the scale on the X axis to go from 0 to 100 with labels every 10 °C. Add minor tick
marks every 5 °C.
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Temperature (°C) | KCI (g) | NaCl (g) | KBr (g) | BaCl, (g)
0.0 27.6 35.7 53.5 31.6
10. 31.0 35.8 59.5 33.3
20. 34.0 36.0 65.2 35.7
30. 37.0 36.3 70.6 38.2
40. 40.0 36.6 75.5 40.7
50. 42.6 37.0 80.2 43.6
60. 45.5 37.3 85.5 46.6
70. 48.3 37.8 90.0 49.4
80. 51.1 38.4 95.0 52.6
90. 54.0 39.0 99.2 55.7
100. 55.6 39.8 104 58.8

Table 8.2: Data for Problem 4

(b) Change the scale on the Y axis to go from 0 to 110 with labels every 10 grams and minor
tick marks every 2 grams.

. Remove the grid lines in the X and Y directions. (Hold Right Click choose Chart Options - Grid
lines tab)

. Add a border to your graph. (Hold Right Click choose Format Plot Area).

. Change the data symbols to all be black and white and size 8. Change the shape so that O =
KCI, O = NaCl, A = KBr and «= BaCl,.

. Use the Insert Tools tab and then shapes draw an arrow pointing to the solubility of NaCl at 20
°C and use the Text Box tool to add a text at the end of the arrow saying "Solubility of NaCl at 20
°C".

. Curve Fitting: Right click on the KBr data and choose the "Add Trend line" option. Under the
"Type" tab choose Linear. Under the "Options" tab click the check box’s for Display Equation and
Display R Value. Draw an arrow from the equation to the trend line.

. Move the Legend to inside your graph in the lower right hand corner. Now drag your graph so it
takes up most of the space in the graphing window. You always want to maximize the size of your
graph so that it is easy to see and read your data.

. Compare this graph to your first graph and make any changes required to make it a "good" graph.
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F. Problem 3 Computer Graph 3

Using the data in the Table 8.3 make a presentable graph from the data. The data you have been
given is experimental data for the Vapor Pressure of Water at Various Temperatures. The temperature
is given in °C and the vapor pressure is measured in torr. Make sure you add a trend line to the graph
using a 3rd order polynomial and make sure to include the equation and the R? value on the graph.

When you are done making your graph, email your instructor your Excel file with your name in it to
jay.mclaughlin@cncc.edu. If you don’t want to email a copy you may print a copy to hand in to your
instructor.

Temperature (°C) | Vapor Pressure (torr)
0 4.6
5 6.5
10 9.2
15 12.8
16 13.6
17 14.5
18 15.5
19 16.5
20 17.5
21 18.6
22 19.8
23 21.2
24 22.4
25 23.8
26 25.2
27 26.7
28 28.3
29 30.0
30 31.8
40 55.3
50 92.5
60 149.4
70 233.7
80 355.7
90 525.8
100 760.0
110 1074.6

Table 8.3: Data for Problem 5
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